CH A P T E R

2

Creating and Analyzing Networks
A project consists of a single network or multiple networks that you analyze and compare. In a project,
you can have multiple copies of a single network with the same customer input data, but use different
options in each to investigate multiple solutions.

2.1 Creating a Project
Use the following procedure to create a single network in a project. A new network is in the Design state.
For more information about the different network states, see the “2.10 Managing the Network Design”
section on page 2-51.

Note

Step 1

All options that the Project Creation Wizard sets can be changed as needed, except Measurement Units
and ANSI/ETSI.
From the File menu, choose New. The Project Creation Wizard appears (Figure 2-1).
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Figure 2-1

Step 2

Project Creation Wizard

In the Project Parameters area complete the following:
•

Created By—Enter a user name. You can enter a maximum of 128 character.

•

Customer Name—Enter the name of the customer requiring this network design. You can enter a
maximum of 128 character.

•

Network Platform Layout—Choose ANSI (the North American standard) or ETSI (the international
standard) from the drop-down list to indicate the platform type. ANSI networks will not allow you
to define SDH (ETSI) service demands. ETSI networks will not allow you to define SONET (ANSI)
service demands.

•

Span Measurement Units—Choose Km (kilometers) or Miles from the drop-down list to set the unit
of measure used for span length.

•

Price List—Choose a price list from the drop-down list.

Step 3

Click Next.
The Choose Platform area appears.

Step 4

In the Choose Platform area, check the desired platform and click Next.
The Choose Release area appears.

Step 5

In the Choose Release area, check the desired software release for the network design and click Next.
The Subnet Options area appears.
To set a default software release see “1.5.2 Setting the Default Software Release” section on page 1-22.

Step 6

In the Subnet Options area, complete the following.
•

Traffic Mapping Algorithm Release 9.1—Check to select the ONS 15454 Software R9.1 version of
the interface and the wavelength routing optimization algorithm to be used in the network design.
Software R9.1 is backward compatible and can manage Software Releases 7.0, 8.0, 8.5, and 9.0.

•

Design Rules Release 9.1—Check to select DWDM Design Rules Release 9.1.
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•

Layout Release 9.1—Check to define the ONS 15454 Software R9.1 version of the algorithm used
to generate the layout of each site within the subnetwork. Software R9.1 is backward compatible and
can manage Software Releases 7.0, 8.0, 8.5, and 9.0.

Figure 2-2

Project Creation Wizard Subnet Page

Step 7

Click Next.

Step 8

Complete one of the following:

Step 9

•

To run the Network Creation wizard, check the Run the Network Wizard Now check box and click
Finish. Continue with Step 9.

•

To create an empty project to add sites and fibers manually, un-check the Run the Network Wizard
Now check box and click Finish. Project Creation wizard creates the project and an empty network
and subnetwork where you can manually add sites and fibers. Skip the remaining steps in this
procedure. To add sites manually, see the “2.2 Adding Sites” section on page 2-13.

In the Topology area of the Network Creation wizard (Figure 2-3), choose one of the following options
from the Network-Topology drop-down list:
•

Ring—Supports both MSTP 15454 ONS and HYBRID 15454 ONS configurations.

Note

In HYBRID 15454 ONS configuration, at least one node must be hub for the ring topology.

•

Linear—Supports both MSTP 15454 ONS and HYBRID 15454 ONS configurations.

•

PSM Line—Supports only MSTP 15454 ONS configuration.

•

PSM Section—Supports only MSTP 15454 ONS configuration.
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Step 10

To instruct Cisco Transport Planner to automatically create a traffic subnet associated with the created
network, check the Create Traffic Subnet check box. Cisco Transport Planner creates (in addition to the
Traffic_ALL) an additional traffic subnet (Traffic_Ring or Traffic_Linear) depending on the topology value
you specify in the Network Creation wizard.
Figure 2-3

Network Creation Wizard Topology Page

Step 11

Click Next.
The Configuration page appears.

Step 12

Choose one of the following options from the node type drop-down list:
•

MSTP 15454 ONS—To create an MSTP 15454 configuration.

•

HYBRID 15454 ONS—To create a 15216 Flex Layer Hybrid configuration.

15216 Flex Layer Hybrid configuration cannot be mixed with the 15454 MSTP configuration. However,
a network can have two clusters one being MSTP and the other 15216 hybrid, without any connection
between the two.

Note

For PSM Line and PSM Section topologies, the only possible configuration is MSTP 15454 ONS and
the node type drop-down list is disabled.
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Step 13

Enter the number of sites in the fields displayed depending on the network topology selected in Step 9.
The following options are available:
Network topology

Fields to be entered...

Maximum, Minimum, and Default
Number of Sites

Ring or

Number of Sites

Maximum: 100

Linear

Minimum: 2
Default: 3

PSM Line

•

Intermediate Sites on Working path

•

Intermediate Sites on Protected path

Both for working and protected
paths:
Maximum: 60
Minimum: 0
Default: 0

PSM Section

Intermediate Sites on Working path

Both for working and protected
paths:
• Intermediate Sites on Protected path
Maximum: 60
•

Minimum: 0
Default: 1
The maximum number of locations where the optical service channel (OSC) can be terminated in a
network is 40. The maximum number of add/drop locations (equipped with WSS, WXC,
multiplexer/demultiplexer, or OADM cards) traversed by an optical circuit is limited to 40.
Step 14

On the Site Name and Topology area, choose the topology for each site from the drop-down list. See
Figure 2-4. Available options are:
Structure
Line

Terminal

Supported
Configurations
•

MSTP
15454 ONS

•

HYBRID
15454 ONS

•

MSTP
15454 ONS

•

HYBRID
15454 ONS

Description
Site with two sides facing two fiber spans. The default site value
for ring topology is Line.

Site with one side facing one fiber span.

Line+

MSTP 15454
ONS

Site with two sides facing two fiber spans that can provide
multidegree expansion capability through an MMU unit.

Terminal+

MSTP 15454
ONS

Site with one side facing one fiber span that can provide
multidegree expansion capability through an MMU unit.
Terminal+ is not allowed for ring network or linear network
topology intermediate sites.

Mutli-degree

MSTP 15454
ONS

Nodes have more than two sides and faces more than two fiber
spans.
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Structure

Supported
Configurations

Description

PSM Terminal Optical Path
Protection

MSTP 15454
ONS

Provides protection for terminal sites at line level through an
optical protection switching module (PSM). In this
configuration, the PSM is directly connected to the fibers after
the amplification stage.

PSM Terminal Multiplex
Section
Protection

MSTP 15454
ONS

Provides protection for terminal sites at multiplex level through
an optical protection switching module (PSM). In this
configuration the PSM is equipped between the mux/demux
stage and the amplification stage.

The site topology options displayed depend upon the restrictions listed in the following table. See
Table 2-1.
Table 2-1

Site Topology Restrictions

If the Network
Topology is...

then...

Ring

You cannot choose the following options:

Linear

PSM Line

PSM Section

•

Terminal

•

Terminal+

•

PSM Terminal - Optical Path Protection

•

PSM Terminal - Multiplex Section Protection

You cannot choose the following options:
•

Terminal for the intermediate sites

•

Terminal+ for the intermediate sites

•

PSM Terminal - Optical Path Protection

•

PSM Terminal - Multiplex Section Protection

You cannot set any topology for the sites. CTP automatically sets the site
topology as follows:
•

PSM Terminal - Optical Path Protection for the two PSM sites

•

Line for the intermediate sites

You cannot set any topology for the sites. CTP automatically sets the site
topology as follows:
•

PSM Terminal - Optical Path Protection for the two PSM sites

•

Line for the intermediate sites

Cisco Transport Planner DWDM Operations Guide, Release 9.1

2-6

78-19089-01

Chapter 2

Creating and Analyzing Networks
Creating a Project

Figure 2-4

Network Creation Wizard- Site Data Page

Step 15

Click Next
The Options area appears.

Step 16

The Options area allows you to define C band and L band rules for the network design Figure 2-5. In the
Options area complete the following:
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•

C-band rules—The C-band options appear in the following format: 80Ch. 50 GHz +1dBm. The
channels available are 80, 72, 64, 40, 32, 20, 16, or 8; the reference per channel power options
available are -1 dBm, +1 dBm, 2 dBm, -2 dBm, +4 dBm, 5 dBm, 7 dBm and 8 dBm; and the spacing
options available are 100 GHz or 50 GHz. You can use even wavelengths for the following channel
designs:
– 80 (40 even wavelengths + 40 odd wavelengths)
– 72 (40 even wavelengths + 32 odd wavelengths)
– 64 (32 even wavelengths + 32 odd wavelengths)

Note

L-band Expand is also supported in the 50 GHz even wavelengths design.

Note

For the HYBRID 15454 ONS configuration, 32 channels is the default value. The channels
available are 8, 16, 20, 32, and 40.

•

L-band Rules— The L-band options appear in the following format: 32 Ch. 100 Ghz +5dBm. The
options available are: None, Expand, and channels available are 32; the reference per channel power
available are 2 dBm and 5 dBm; and, the spacing options available is 100 GHz.

Note

L-Band is not applicable for the HYBRID 15454 ONS configuration.

Note

If you use a Line+ or Multidegree site, you must select design rules based on 100 GHz channel spacing,
and in the case of Line+, you must also select 32-channel rules. If these conditions are not met,
Cisco Transport Planner will provide an error message when you attempt to analyze the network. See
Table 4-1 for additional details on site design rules.
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Figure 2-5

Network Creation Wizard Options Page

Step 17

Click Next
The Site Management area appears.

Step 18

In the Site Management area, complete the following. See Figure 2-6.
•

Shelf Management—Choose the shelf management configuration:
– Multi Shelf Integrated Switch—All the Multi Service Transport Platform (MSTP) optical cards

(optical add/drop multiplexers [OADMs] and amplifiers) reside in different shelves connected
by a LAN. The LAN is implemented with switches connected to the MSTP shelves. For this
option, Multi-Shelf Integrated Switch Cards (MS-ISC) are used to support the multishelf
configuration.
– Multi Shelf External Switch—All the MSTP optical cards (OADMs and amplifiers) reside in

different shelves connected by a LAN. The LAN is implemented with switches external to the
MSTP shelves (Cisco Catalyst 2950). For this option, two external Ethernet switch units are
used to support the multishelf configuration.
– Individual Shelf—All the MSTP optical cards (OADMs and amplifiers) reside in the same shelf.

For this option, multishelf management is not supported; every shelf is managed as an
independent shelf.

Note

Shelf Management is disabled for HYBRID 15454 ONS configuration.
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Note

•

If you select the Shelf Management type as Multi Shelf Integrated Switch or Multi Shelf
External Switch, you can modify the MSM Shelf ID for Multi Shelf Management
Configuration. To modify the MSM Shelf ID, refer “3.2.6 Viewing the Layout of Single
Site” section on page 3-14.

Node Protection—Choose Same Shelf (single shelf configurations) or Separated Shelves
(multishelf configurations). Same Shelf configuration places all the OADM/ROADM units in a
single shelf, and does not provide any protection at the shelf level in the node. Separated Shelves
places OADM/ROADM units (west-facing and east-facing) in separate shelves in the node and it is
selectable only if Multishelf management is selected. You can also set node protection for a
multidegree node.

Note

Node protection is disabled for HYBRID 15454 ONS configuration with an auto-selected
value of Same Shelf.

•

Hybrid Site Config—Check to create all the nodes configured as hybrid MSTP/Multi Service
Provisioning Platform (MSPP) nodes. Hybrid Node is only available if you chose Individual Shelf
as the Shelf Management type.

•

OSMINE Compliant—Check this option to place the DWDM units in the shelves according to
Operations Systems Modifications for Integration of Network Elements (OSMINE) placement rules.

•

DCC Chain—Check to put a TXP(P)_MR_2.5G card in slot 12 on each shelf of each site to use
DCC.

•

Max Shelves per Rack—Choose the maximum number (from 1 to 4) of ANSI or ETSI shelves
(equipping optical cards or TXP/MXP cards) that can be placed in each rack in the site when
generating the layout of the site.

•

Installation w/o M/P—Check this box to design a network that does not require the setup of
configuration files (thresholds and setpoints). Installation without Cisco Transport Planner is also
known automatic node turn up. When this feature is enabled, the software in the node will configure
itself with parameters; XML configuration files are not required to configure the node. When this
option is selected at the end of EDFA and DCU placement, Cisco Transport Planner will analyze the
resulting network and verify that in each node, where the option installation w/o Cisco Transport
Planner is enabled, has:
– A preamplifier in each direction.
– All amplifiers working in gain control mode.
– A flat node output spectrum, that is, the resulting channel tilt at the exit of the node is 0.
– A feasible setpoint forced during simulation.
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Figure 2-6

Network Creation Wizard Sites Page

Step 19

Click Next.
The Span Parameters area appears.

Step 20

In the Span Parameters area, complete the following. See Figure 2-7.
•

Span Label Tag—Enter the desired span label.

•

Span Fiber Type—Choose the fiber type for each span in the network.

•

Span Length—Enter the span length. The displayed unit of measure is retrieved from the
Span Measurements Units field.

•

EOL Ageing Factor—Type the number to use when factoring fiber aging. This factor is multiplied
by the SOL total span loss without connectors.

•

EOL Ageing loss [dB]—Type the EOL aging loss value. The EOL loss-per-span value is added at
the end of life to each discrete fiber in the network (for example, to add an EOL margin for splicing).

Note

•

Enter a value in either EOL Ageing Factor or EOL Ageing loss; you do not need to enter a
value in both fields. Use one of the following formulas to calculate the fiber loss at SOL:
SOL = km * dB/km + (2 * connector loss)
SOL = user entered loss + (2 * connector loss)
Use one of the following formulas to calculate the fiber loss at EOL:
EOL = km * dB/km * EOL Aging Factor + (2 * connector loss) + EOL Aging Loss
EOL = user entered loss * EOL Aging Factor + (2 * connector loss) + EOL Aging Loss

Connector loss [dB]—Type the concentrated loss at the end of the span.
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•

CD factor [ps/mn/km]—Type the fiber chromatic dispersion (CD) factor. The default value is
dependent on the selected fiber type. Any value that you enter in this field is lost whenever you
change the fiber type. Chromatic dispersion is always entered in ps/nm/km. Fiber chromatic
dispersion is defined for the middle of the wavelength band. C-band is defined at 1545.3 nm; L-band
is defined at 1590.4 nm.

•

PMD factor [ps/sqrt(km)]—Type the polarization mode dispersion (PMD) factor. The default value
is dependent on the selected fiber type. Any value that you enter in this field is lost whenever you
change the fiber type. PMD is always entered per kilometers.

•

Length Based Loss—If checked, the fiber loss is determined by Span Length * Loss Factor. If the
check box is not checked, you must enter the total loss of the span.

•

Loss factor [dB/km]—Type the value of the SOL fiber loss per kilometer that is used to calculate
the loss of each span in the network. The fiber loss factor is always entered in dB/km.

•

Tot SOL loss w/o conn [dB]—Type the start of life link fiber loss for each span, without the
connector concentrated loss. The total SOL loss without connectors is equal to the loss factor
multiplied by the length. In the Length Based model, this value is calculated automatically.

•

DCN extension—Click the check box to use DCN extensions on each of the spans in the network.
This implies that the OSC channel is not used to connect the two nodes. All nodes facing a span with
the DCN Extension option enabled require a ITU-T G.709 generic communications channel (GCC)
access that must be provided by the customer.

Note

Figure 2-7

For HYBRID 15454 ONS configuration, this option is disabled by default.
Network Creation Wizard Span Page
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Step 21

Note

Click Finish. CTP checks the validity of the fiber factor values. If the fiber factor values are within the
valid range (Table 2-2), CTP creates a visual representation of the network. If the values are out of range,
CTP issues a warning, asking you to confirm the input values.

All options set by the Network Creation Wizard can be changed as needed per site and per span.
Table 2-2

Valid Ranges for Fiber Factor Values

Fiber Type

Parameter

Min.
Error
Value

ITU-T
G.652-SMF

Loss factor

0

0.2

—

0.4

10

dB/km

Chromatic
dispersion factor
at 1545.3 nm
(C-band)

0

16.2

16.7

17.1

30

ps/nm/km

Chromatic
dispersion factor
at 1590.4 nm
(L-band)

0

18.53

19.03

19.43

30

ps/nm/km

PMD factor

0

0.0

0.1

0.5

10

0

0.2

—

0.4

10

dB/km

0

3.4

3.80

4.2

10

ps/nm/km

PMD factor

0

0

0.1

0.5

10

Loss factor

0

0.2

—

0.4

10

dB/km

Chromatic
dispersion factor
at 1545.3 nm

0

3.8

4.19

4.6

10

ps/nm/km

PMD factor

0

0

0.1

0.5

10

Loss factor

0

0.2

—

0.4

10

dB/km

Chromatic
dispersion factor
at 1590.4 nm
(L-band)

0

2.43

2.83

3.23

30

ps/nm/km

PMD factor

0

0

0.1

0.5

10

ITU-T
Loss factor
G.655-E-LEAF Chromatic
dispersion factor
at 1545.3 nm
ITU-T
G.655-True
Wave

ITU-T
G.652-DS
(Dispersion
shifted)

Min.
Warning
Value

Default
Value

Max.
Warning
Value

Max.
Error
Value

Unit

2.2 Adding Sites
Use the following procedure to add new sites to an existing network. A site is a customer premise
equipment (CPE) where any equipment can be co-located in a rack within a building. Cisco Transport
Planner supports up to 100 sites in a network. The number of racks and nodes in a site is independent of
the number of sites in the network. The maximum number of locations where the OSC can be terminated
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in a network is 40. When the number of locations where the OSC is terminated exceeds the maximum
supported value, the tool completes the design, but in the summary report an alarm is reported to indicate this
situation. The maximum number of add/drop locations in a network is 40. The maximum number of
add/drop locations (equipped with WSS, WXC, multiplexer/demultiplexer, or OADM) traversed by an optical
circuit is limited to 40.

Note

Every new site added to a design is automatically configured as Multi-Shelf Integrated Switch with Same
Shelf protection. To change this, you can edit the site properties after adding it to the network design.
See the “4.3 Editing Site Parameters” section on page 4-2.

Step 1

Right-click the network folder in the Project Explorer and choose Expand from the shortcut menu.

Step 2

Right-click the Sites folder and choose New Site from the shortcut menu. The Site Creation wizard
appears (Figure 2-8). As an alternative, if sites already exist in the network design and you have the
NtView Name tab open, click the Create a new site icon in the toolbar. For more information about the
Cisco Transport Planner icons, see Appendix A, “GUI Information and Shortcuts.”

Step 3

Choose the Node Type:

Step 4

•

MSTP 15454 ONS

•

HYBRID 15454 ONS

Choose the interface type:
•

Line—Two pairs of fibers are terminated at the node.

•

Terminal—A single pair of fibers is terminated at the node.

•

Line+—Two pairs of fibers are terminated at the node but the number of fibers can be increased. An
MMU card (topology upgrade) must be installed.

•

Terminal+—A single pair of fibers is terminated at the node but the number of fibers can be
increased. An MMU card (topology upgrade) must be installed.

•

Multi-degree—Nodes have more than two sides and face more than two fiber spans.

•

PSM Terminal - Optical Path Protection—Provides protection for terminal sites at Line level
through an optical protection switching module (PSM). In this configuration, the PSM is directly
connected to the fibers after the amplification stage.

•

PSM Terminal- Multiplex Section Protection—Provides protection for terminal sites at multiple
levels through an optical protection switching module (PSM). In this configuration the PSM is
equipped between the mux/demux stage and the amplification stage.

Note

Step 5

In the HYBRID 15454 ONS configuration, the supported interface types are line and
terminal.

Click Finish.
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Figure 2-8

Site Creation Wizard

2.3 Adding Fiber Spans
Use the following procedure to manually add fiber spans between sites. A fiber span consists of a pair
of fibers (one transmit and one receive) between two sites. A span is represented by a fiber duct in the
NetViewName tab. Within a fiber duct, more than one fiber pair can exist.

Note

The number of fiber spans that each site can support is defined in the site properties. See the
“2.2 Adding Sites” section on page 2-13 or the “4.3 Editing Site Parameters” section on page 4-2.

Step 1

In the NtView Name tab, click the Create a new duct icon in the toolbar. For more information about the
Cisco Transport Planner icons, see Appendix A, “GUI Information and Shortcuts.”

Step 2

Click one of the sites that you want to connect with a fiber span. This site will be the source site for later
network analysis output.

Step 3

Click the destination site. A fiber span appears between the two sites. This site will be the destination
site for later network analysis output.
For the first span, the source site is set as A and the destination site is set as B. Cisco Transport Planner
automatically adjusts East and West for additional spans.
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Note

HYBRID 15454 ONS configuration cannot be connected to the 15454 MSTP configuration.
However, a network can have two clusters one being MSTP and the other 15216 hybrid, without
any connection between the two.

2.4 Creating an Optical Subnet
An optical subnet is a collection of spans with certain associated, defined, common properties. You can
define distinct optical subnets on the same network and can also set a list of associated properties on
each of them.
The following properties are supported in an optical subnet:
•

C-band Rules—Allows you to define rules for the C-band channels, the maximum per channel
power, and the channel spacing for the design.

•

L-band Rules—Allows you to define, for the L-band channels, the maximum per channel power, and
the channel spacing for the design.

When you create a new project (see the “2.1 Creating a Project” section on page 2-1), Cisco Transport
Planner automatically creates an optical subnet associated to the network. At least one optical subnet
(even if empty) must exist for each network in a project.
You can create an optical subnet using the Project Options (default) Optical Subnet property (Design
Rules) values. To do this:
Step 1

Select the Optical Subnet folder in Project Explorer. The Optical Subnet Pane appears in the Task Pane
on the right side of the screen (Figure 2-9).
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Figure 2-9

Step 2

Creating Optical Subnet

Click Create. The Create Optical Subnet dialog box appears (Figure 2-10). The default name, which
is a combination of the user-created C-band and L-band rules, and the wizard-created default C-band and
L-band rules are displayed.
Figure 2-10

Create Optical Subnet Dialog Box

Step 3

Select C-band and L-band design rules from the C Design Rule and L Design Rule drop-down lists for
the new optical subnet that you want to create.

Step 4

Click OK. A new optical subnet with the design properties you selected is created and placed in project
explorer under the Optical Subnets folder.

Note

You cannot create more then one optical subnet with the same properties values and each span must be
part of only one optical subnet.
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Cisco Transport Planner allows you to do the add or remove spans, edit designs rules, define an optical
subnet as current, and to delete an optical network. To do these, select the optical subnet you want to
change in Project Explorer under the Optical Subnets in the Tasks Pane, and choose the following:

Note

•

Add/Remove Spans—Adds or removes the spans that are included in a given optical subnet.

•

Edit Design Rule—Modifies the property value of the design rule of a new or existing optical subnet.

•

Set as Current—CTP automatically defines the optical subnet with the greatest number of spans.

•

Delete—Deletes the optical subnets in the Tasks Pane.

When you delete an optical subnet, all the spans contained in the deleted optical subnet are placed within
the current optical subnet. In case the current optical subnet is deleted, all their spans will be
automatically placed within the optical subnet with the greatest number of spans. When the current
optical subnet is removed, the tool automatically defines as current the optical subnet with the greatest
number of contained spans.

2.5 Adding Notes to a Project
Use the following procedure to add a note to any item in the Project Explorer. Each network has a Notes
folder in the Project Explorer. After you have created a note, it appears in the Notes folder for that
particular network.
Step 1

Right-click the desired item in the Project Explorer and choose Edit Note from the shortcut menu.

Step 2

In the Edit Note creation box, enter the desired text.

Step 3

To close the Edit Note creation box and to save the note, click the X in the upper right corner of the
window.

Step 4

To view notes, double-click the Notes folder. The Notes window appears. Table 2-3 lists the columns in
the Notes window.
Table 2-3

Step 5

Notes Window

Column

Description

Header

Displays the note text. To view the entire note, click the plus (+) sign next to the header
to expand the text.

Action

Click Go to open the item in the Project Explorer where the note was created.

Source

Displays the location of the note, for example, ProjectManager.Nets.Net2.Sites.Site2.W.

To close the Notes window, click the X in the upper right corner of the window.

Cisco Transport Planner DWDM Operations Guide, Release 9.1

2-18

78-19089-01

Chapter 2

Creating and Analyzing Networks
Creating Traffic Subnet

2.6 Creating Traffic Subnet
Step 1

In the Project Explorer tab, scroll down to Traffic Subnets. Right-click Traffic Subnets, and select
Create.
The Traffic Subnet Creation wizard appears. See Figure 2-11.
Figure 2-11

Step 2

Note

Traffic Subnet Creation Wizard

Select the Topology for the subnet from the drop-down list (Ring, Linear, and Mesh), then click Next.

If Ring or Linear topology is selected for the subnet, the spans in the subnet must be adjacent and also
ordered.

Step 3

Click Press to build new subnet. The Traffic Subnet Builder Wizard appears (Figure 2-12).

Step 4

Select the ducts that should be a part of the subnet from the list displayed on the left handside, and click
OK. This takes you back to the Traffic Subnet Creation Wizard.

Step 5

Click Finish to complete the creation of the traffic subnet. The created subnet appears in Project
Explorer under Traffic Subnets.
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Figure 2-12

Traffic Subnet Builder Wizard

2.7 Creating a Demand
Cisco Transport Planner provides five types of service demands:
•

Point-to-point

•

Protected ring (P-ring)

•

ROADM

•

Ethernet aggregated

•

TDM aggregated

You can also create regeneration sites while creating a service demand.

2.7.1 Manual Regeneration
In optical networks, as the fiber length increases, a loss in the signal ratio and power could occur due to
attenuation and dispersion. A regenerator is required to recreate the weak and distorted optical signals
through reamplification, regeneration, and retiming processes. The regenerators remove noise and
distortion, convert the optical signal to an electrical signal, and then convert the signals back to optical
signals (O-E-O conversion).
Cisco Transport Planner supports the creation of regeneration sites in the network. Regeneration is
supported for the following demands:
•

Point-to-point
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•

P-ring

•

Ethernet Aggregated

•

TDM Aggregated

The demand is displayed in the following manner:
Demand > Service > Trail > Section
•

“Service” is the circuit through which traffic flows between nodes.

•

“Trail” is the network section joining two traffic nodes. By default, a trail has only one single
section. The trail can be split in different regeneration sections.

•

“Section” is a contiguous subset of the span.

A new section is added whenever a regeneration site is created. The sections can have different
wavelengths based on availability. Regeneration can be performed using any two cards back-to-back
(OTU2_XP, TXP, or MXP) or with a dedicated regenerator card.

2.7.2 Creating a Point-to-Point Demand
Use the following procedure to add a point-to-point traffic demand:
Step 1

In the NtView Name tab, click the Create new Point-to-Point demand icon in the toolbar. For more
information about the Cisco Transport Planner icons, see Appendix A, “GUI Information and
Shortcuts.”

Step 2

Click the source site of the demand.

Step 3

Click the destination site of the demand. The Point to Point Demand Creation Wizard appears
(Figure 2-13).

Step 4

From the drop-down list, select Traffic Subnet ALL or any of the previously created traffic subnets to
which this service demand should be part of, and proceed to Step 5. If you wish to create a new traffic
subnet see “2.6 Creating Traffic Subnet” section on page 2-19.

Step 5

Click Next.
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Figure 2-13

Step 6

Point to Point Demand Creation Wizard

On the General Parameters page, complete the following:
•

Label—Type the name of the demand.

•

Source—(Display only) Displays the source site name.

•

Destination—(Display only) Displays the destination site name.

•

Service Type—Choose the service type from the drop-down list. For a list of services, see the
“1.1.2.5 Service Support” section on page 1-7.

•

Present # ch—Enter the number of channels to be created. The Forecast # ch field automatically
updates with the number entered in this field.

•

Forecast # ch—Enter the number of channels to be installed at a later date. This value includes the
Present # ch value. For example, if you entered 4 in the Present # ch value and want to add two
channels in the future, enter 6.

Step 7

Click Next.

Step 8

On the Platform Parameters page, complete the following:
•

Protection—Choose the protection type from the drop-down list: Client 1+1, Fiber Switched,
PSM-OCH, or Unprotected. For more information on protection types, see the “1.1.2.4 Protection
Scheme Support” section on page 1-6.

•

Path—(Unprotected only) Choose the routing type from the drop-down list:
– Auto—Allows the highest degree of flexibility in routing the channels. Cisco Transport Planner

routes the channels with the lowest possible cost, given the other constraints.
– A—Select this for a Terminal or a Terminal+ site.
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– A or B—Select either of these for a Line or a Line+ site.
– A, B, C, or D—Select either of these for a Multidegree site if four ducts are connected.
– A, B, C, D, E, F, G, or H—Select either of these for a Multidegree site if eight ducts are

connected.
– Aw or Ap—Select either of these for a PSM Terminal - Optical Path Protection or PSM Terminal

- Multiplex Section Protection site.
•

Step 9

Optical Bypass—(Unprotected only) Choose the site where the channels for the current demand will
be optically bypassed. A channel in optical bypass is dropped on one side of the node and added on
the other side of the same node to allow the future use of that node as an add/drop location.

Complete the following fields in the Interface Parameters area. The options available are based on the
service type selected in Step 6.
•

Transponder—Click to expand, then check the Card Type check box to select the card at the end
sites of the service channels.
If you have selected the Service Type as LAN-WAN Conversion in Step 6, when you expand
Transponder, select any one of the following OTU2-XP LAN-WAN modes and then proceed to step
Step 10:
– OTU2-XP- Mixed Mode—Select the card type as OTU2-XP Mixed Mode if the Protection type

is either Unprotected, Client 1+1, or PSM-OCH.
– OTU2-XP- Txp Mode—Select the card type as OTU2-XP Txp Mode if the Protection type is

either Unprotected, Client 1+1, or PSM-OCH.
– OTU2-XP- Splitter Mode—Select the card type as OTU2-XP Splitter Mode if the Protection

type is Fiber-Switched.

Note

Step 10

•

Line Card—Click to expand, then check the Card Type check box to select the card at the end sites
of the service channels.

•

Alien Card—Appears only if you created a third-party interface as described in the “1.5.5 Defining
Third-Party DWDM Interfaces” section on page 1-31. Click to expand, and then check the card type
check box to select the card at the end sites of the service channels.

•

Pluggable Card—Click to expand, then check the card type check box to select the card at the end
sites of the service channels.

In the Client Interface area, define the client interface type for the source (SR, ZR, ER, or LR) and
destination (EW, SW, or LW) from the Source and Destination drop-down list. This option is available
for transponder and muxponder interfaces that have pluggable client interfaces that depend on the
selected service type and card type.

Note

Step 11

Y-cable protection is not supported on the LAN to WAN interface (ports 1 and 3)

In the LAN-WAN conversion mode, CTP automatically selects the Source and Destination client
interface type if you have not selected the Source and Destination client interface type.

Click Finish. The Demand Editor dialog box appears listing the present and forecast channels.
The demand appears in the NtView name tab and in the Project Explorer tree in the
Service Demands > Point To Point folders. A demand is a solid line when selected and a dotted line when
not selected. The line has a number above it that indicates the number of channels that are present.
Figure 2-14 shows a selected point-to-point demand with five channels between sites 1 and 2.
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Figure 2-14

Point-to-Point Demand Between Two Sites

Step 12

To add a new service, click the Add new service icon in the toolbar. A new row appears. Complete the
parameters for the new channel.

Step 13

To delete an existing channel, select the row and click the Delete service icon in the toolbar.

Step 14

To set path constraints, click the Path Constraints Editor icon in the toolbar and complete the following
as required:
•

Output Node Interface—Choose from the drop-down list, the side through which the demand must
be routed.

•

Exclude Sites—Choose the sites that must be excluded from the demand route.

•

Exclude Ducts—Choose the ducts that must be excluded from the demand route.

Step 15

To add a regeneration site, click the Regeneration... icon in the toolbar. The Regeneration editor
appears. The regeneration site can be created only at the trail level. For more information, see the
“2.7.7 Creating a Regeneration Site” section on page 2-43.

Step 16

Click OK to save the changes to the channels and close the Demand editor dialog box, or Cancel to close the
dialog box without saving the changes.

Note

To make changes to the demand parameters, see the “4.6 Editing a Point-to-Point Demand” section on
page 4-26, or click Cancel to close the Demand Editor dialog box.

Note

For each network, Cisco Transport Planner automatically creates a default subnet that exactly matches
the overall network topology. This cannot be deleted.

2.7.3 Creating a Protected Ring Demand
Use the following procedure to create a P-ring traffic demand.
Step 1

Create a ring network using either the procedures in the “2.1 Creating a Project” section on page 2-1 or
by manually placing sites into a ring configuration.

Step 2

In the Native Net# tab, click the Create new P-Ring demand icon in the toolbar. The P-Ring Creation
Wizard appears (Figure 2-15). For more information about the Cisco Transport Planner icons, see
Appendix A, “GUI Information and Shortcuts.”

Cisco Transport Planner DWDM Operations Guide, Release 9.1

2-24

78-19089-01

Chapter 2

Creating and Analyzing Networks
Creating a Demand

Figure 2-15

P-Ring Creation Wizard

Step 3

For each network, the tool automatically creates, a default subnet that exactly matches the overall
network topology. This cannot be deleted. From the drop-down list, select any previously created traffic
subnet with a ring topology that this circuit should be part of and proceed to Step 4. If you wish to create
a new traffic subnet see 2.6 Creating Traffic Subnet, page 2-19.

Step 4

On the General Parameters page, complete the following:
•

Label—Enter the name of the demand.

•

Service Type—Choose the service type from the drop-down list. For a list of services, see the
“1.1.2.5 Service Support” section on page 1-7.

•

Present # ch—Enter the number of channels to be created. The Forecast # ch field automatically
updates with the number entered in this field.

•

Forecast # ch—Enter the number of channels to be installed at a later date. This value includes the
Present # ch value. For example, if you entered 4 in the Present # ch value and want to add two
channels in the future, enter 6.

Step 5

Click Next.

Step 6

On the Sites Selection page, in the Protection Sites area, press Ctrl and click the sites that you want to
add to the P-ring. A P-ring requires at least two sites. Click the right arrow button. To remove a site added
to the list, click the site and click the left arrow button.
In the Optical Bypass area, press Ctrl and click the sites that you want to add to the P-ring. Click the
right arrow button. To remove a site added to the list, click the site and click the left arrow button.

Step 7

Click Next.

Step 8

On the WDM Client Selection page, complete the following interface parameters. The options available
are based on the service type selected in Step 4.
•

Transponder—Click to expand, then check the Card Type check box to select the card at the end
sites of the service channels.
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If you have selected the Service Type as LAN-WAN Conversion in Step 4, when you expand
Transponder, select any one of the following OTU2-XP LAN-WAN modes:
– OTU2-XP- Mixed Mode—Select the card type as OTU2-XP Mixed Mode if the Protection type

is either Unprotected, Client 1+1, or PSM-OCH.
– OTU2-XP- Txp Mode—Select the card type as OTU2-XP Txp Mode if the Protection type is

either Unprotected, Client 1+1, or PSM-OCH.
– OTU2-XP- Splitter Mode—Select the card type as OTU2-XP Splitter Mode if the Protection

type is Fiber-Switched.
•

Line Card—Click to expand, then check the card type check box to select the card at the end sites
of the service channels.

•

Alien Card—Appears only if you created a third-party interface as described in the “1.5.5 Defining
Third-Party DWDM Interfaces” section on page 1-31. Click to expand, and then check the card type
check box to select the card at the end sites of the service channels.

•

Pluggable Card—Click to expand, then check the card type check box to select the card at the end
sites of the service channels.

In the Client Interface area, define the client interface type for the source (SR, ZR, ER, or LR) and
destination (EW, SW, or LW) from the Source and Destination drop-down list. This option is available
for transponder and muxponder interfaces that have pluggable client interfaces that depend on the
selected service type and card type.

Note

Step 9

In the LAN-WAN Conversion mode, CTP automatically selects the Source and Destination
client interface type if you have not selected the Source and Destination client interface type.

Click Finish. The Demand Editor dialog box appears.
The demand appears in the NtView name tab and in the Project Explorer tree in the
Service Demands > P-Rings folders. A demand is a solid line when selected and a dotted line when not
selected. The line has a number above it that indicates the number of channels present. Figure 2-16
shows a selected one-channel P-ring between sites 1, 2, 3, and 5 with an optical bypass of site 4.

Step 10

To add a new service, click the Add new service icon in the toolbar. A new row appears. Complete the
parameters for the new channel.

Step 11

To delete an existing channel, select the row and click the Delete service icon in the toolbar.

Step 12

To add a regeneration site, click the Regeneration... icon in the toolbar. The Regeneration editor
appears. The regeneration site can be created only at the trail level. For more information, see the
“2.7.7 Creating a Regeneration Site” section on page 2-43.

Step 13

Click OK to save the changes to the channels and close the Demand Editor dialog box, or Cancel to close
the dialog box without saving the changes.

Note

To make changes to the demand parameters, see the “4.7 Editing a P-Ring Demand” section on
page 4-28, or click Cancel to close the Demand Editor dialog box.
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Figure 2-16

P-Ring Demand

2.7.4 Creating a ROADM Demand
Use the following procedure to create ROADM traffic groups and demands:
Step 1

In the Project Explorer, under Nets, right-click the ROADM folder and choose New ROADM Group.
The ROADM Group Creation Wizard appears.

Step 2

Select the desired traffic subnet from the Traffic Subnet field. You can create a new traffic subnet if
desired using the “2.6 Creating Traffic Subnet” section on page 2-19.

Step 3

Type the ROADM traffic group name in the Group Name field.

Step 4

Check the desired sites.

Step 5

Click Finish. The new ROADM traffic group appears under the ROADM folder in the Project Explorer.

Step 6

Right-click the new ROADM traffic group and choose Create new ROADM demand from the shortcut
menu. The Create ROADM Demand dialog box appears (Figure 2-17).
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Figure 2-17

Create ROADM Demand Dialog Box

Step 7

Enter a name for the demand in the Demand Name field.

Step 8

Select a traffic pattern type (Hub, Meshed, or Ring) from the Traffic Type drop-down list:
•

Hub—If you select Hub, select the originating site from the First Site drop-down list.

•

Meshed—If you select Meshed, go to Step 9.

•

Ring—If you select Ring, select the Connectivity type as either Unprotected Minimum Hop,
Unprotected Optimum Path, or Unprotected Subnet, and proceed to Step 10

Note

Refer to the “1.1.5.3 ROADM Traffic Demands” section on page 1-13 for more information on the
connectivity choices.

Step 9

Select a connectivity type from the Connectivity Type drop-down list: Protected, Unprotected
Minimum Hop, Unprotected Optimum Path, or Unprotected Subnet. If you chose Unprotected
Subnet, continue with the next step; otherwise proceed to Step 11.

Step 10

If you chose Unprotected Subnet, choose the starting site and the direction the ring must be traversed
from the drop-down lists.

Step 11

In the Service Types list, check the boxes for one or more client service types for the ROADM demand.
The client interfaces that support each service type appear in the table to the right of the Service Types
list.

Step 12

To further define the client interfaces, complete the following options for each client interface listed in
the table. Check boxes in gray are not available for selection.
•

Yes/No—Check to select this card to implement the service type.

•

Client Interface—(Display only) Displays the card type for the selected service type.

•

Y Protected—Check to select Y-cable protection if the connectivity type is Protected.

•

1+1 Protected—Check to select 1+1 protection if the connectivity type is Protected.

•

Fiber Switched—Check to select fiber-switching protection if the connectivity type is Protected.

•

Supported Service—(Display only) Displays the service types supported for the card.
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You can select more than one client interface to support the same service type. By default,
Cisco Transport Planner checks the best client interface to support each service.
Step 13

Click OK to create the demand.

Step 14

To finalise the ROADM demand, complete the following steps:
a.

Analyse the network.

b.

Upgrade the analysed network.

c.

In the upgraded network, go to the card listed under the ROADM demand, select the required
connectivity (for example, Site1 - Site2), right-click and select the Finalize connectivity option. The
ROADM Finalise Connectivity Wizard appears.

d.

On the General Parameters page, complete the following:

•

Label—Enter the name of the demand.

•

Service Type—Choose the service type from the drop-down list. For a list of services, see the
“1.1.2.5 Service Support” section on page 1-7.

•

Present # ch—Enter the number of channels to be created. The Forecast # ch field automatically
updates with the number entered in this field.

•

Forecast # ch—Enter the number of channels to be installed at a later date. This value includes the
Present # ch value.

e.

In the Platform area of the Platform Parameters page, complete the following:

•

Protection—Choose the protection type from the drop-down list: Y-Cable Protected, or Client 1+1.
For more information on protection types, see the “1.1.2.4 Protection Scheme Support” section on
page 1-6.

f.

In the 454DWDM area, complete the following:

•

Transponder—Click to expand, then check the card type check box to select the card at the end sites
of the service channels.

g.

In the Client Interface area, define the client interface type (SR, IR, or LR) for the source and
destination from the Source and Destination drop-down lists. This option is available for
transponder and muxponder interfaces that have pluggable client interfaces that depend on the
selected service type and card type.

h.

Click Finish. The Demand Editor dialog box appears listing the present and forecast channels.

i.

To add a new service, click the Add new service icon in the toolbar. A new row appears. Complete
the parameters for the new channel.

j.

To delete an existing channel, select the row and click the Delete service icon in the toolbar.

k.

To add a regeneration site, click the Regeneration... icon in the toolbar. The Regeneration editor
appears. The regeneration site can be created only at the trail level. For more information, see the
“2.7.7 Creating a Regeneration Site” section on page 2-43.

l.

Click OK to save the changes to the channels and close the Demand editor dialog box, or Cancel to close
the dialog box without saving the changes.

m.

Analyse the upgraded network again.
The demands that were finalized appear in the reports.
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2.7.5 Creating Ethernet Aggregated Demands
An Ethernet aggregated demand is a collection of low-rate Gigabit Ethernet/10Gigabit Ethernet services
that can be aggregated on a single 10-Gbps wavelength division multiplexing (WDM) trunk. This
demand is supported only by the GE_XP, 10GE_XP, GE_EXP, and 10GE_EXP cards when configured
as an L2-Switch.
The Ethernet Aggregation Creation wizard allows you to:
•

Create one WDM transport channel at a time over a predefined traffic subnet.

•

Specify the wavelength to be used for the channel, and define a list of locations with add/drop VLAN
circuit capability.

•

Create a set of desired VLAN circuits on this WDM transport channel.

•

The check functionality generates a report showing for each section of the subnet where the WDM
transport channel is over allocated and then perform corrective action when required.

•

The clone functionality creates an identical copy of the current WDM transport channel with the
same add/drop sites and WDM channel configuration parameters. You can then start filling this
channel with the desired circuits.

Use the following procedure to create Ethernet aggregated demands:
Step 1

In the NtView name tab, click the Create new AggregatedEthernet demand icon in the toolbar. For
more information about Cisco Transport Planner icons, see Appendix A, “GUI Information and
Shortcuts.” The EthernetAggr Creation Wizard appears (Figure 2-18).

Figure 2-18

Step 2

Ethernet Aggregation Creation Wizard

Choose the desired traffic subnet from the Traffic Subnet drop-down list. You can create a new traffic
subnet if desired (see 2.6 Creating Traffic Subnet, page 2-19).
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Step 3

Click Next.

Step 4

In the General Parameters pane, enter values in the following fields:
•

Label—Type the name of the demand. The default value is EthernetAggr1.

•

Present/Forecast—Check this box if this demand will be needed in the future; uncheck this box if
this demand is needed now. This parameter drives the list of pluggable port modules to be equipped
on the card and will affect BoM reports.

Step 5

Click Next.

Step 6

In the Sites selection pane, complete the following tasks:

Step 7

•

In the Protection Sites area, press Ctrl and click the sites that you want to add to the Ethernet
aggregated demand. An Ethernet aggregated demand requires at least two sites. Click the right arrow
button. To remove a site added to the list, click the site and click the left arrow button.

•

In the Optical Bypass area, press Ctrl and click the sites that you want to add to the Ethernet
aggregated demand. Click the right arrow button. To remove a site added to the list, click the site
and click the left arrow button. If the Present/Forecast check box is checked, you cannot select
Optical Bypass sites. A channel in optical bypass is dropped on one side of the node and added on
the other side of the same node to allow the future use of that node as an add/drop location.

In the Node Configuration selection pane, enter values for the following options:
•

DWDM Trunk—Select the DWDM trunk type. You can specify the kind of WDM trunk interface
for the card in each add/drop site. Allowed values are:
– Auto
– w/EFEC
– w/FEC
– w/o FEC

•

Wavelength—Select the WDM transport channel wavelength. This option allows you to force the
current WDM transport channel wavelength. Wavelengths are listed based on the selected band.
Allowed values are:
– Auto—Allows CTP to assign a wavelength to the channel with the lowest possible cost, given the

other set of constraints.
– C band-32 ch.odd
– L band- 32 ch.odd
– C band- 40 ch
– C band- 64 ch
– C band-72 ch
– C band- 80 ch
•
Step 8

New CFG—Choose the desired card type for each of the protected sites.

Click Finish. The name Demand window appears (Figure 2-19).
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Figure 2-19

Step 9

EthernetAggr1 Demand Window, TrafficTab

To add a circuit, click the Create a new circuit icon. The New Request window appears (Figure 2-20).
Figure 2-20

New Request Window
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Step 10

The New Request window contains four areas of information: Quantity, General, Src, and Dest.
Quantity Area
Quantity—Enter the number of circuits to be created.
General Area
•

Label—Enter the label for the circuit. By default, VLAN_Circuit_x is used.

•

Trunk Protection—Enter the trunk protection type. Allowed values are:
– Unprotected
– Protected

•

P/F—Select Forecast if this demand will be needed in the future. Select Present if this demand is
needed now. This parameter drives the list of pluggable port modules to be equipped on the card and
affects BoM reports.

•

Path Forcing—This option allows you to force the circuit routing on the traffic subnet associated
with this demand. Allowed values are:
– Auto—(Default) Causes the tool to automatically define the trunk path.
– Side x—Represents the label of the side on the Src site where the circuit is routed.

•

Client Protection—Allowed values are:
– Unprotected
– Client 1+1

•

Circuit rate—Displays the allowed circuit rates.

Src Area
•

Site—Select the source site. Allowed values include the list of sites added in the WDM traffic
channel.

•

SFP lambda—Select the desired SFP/XFP for this port or set it to Auto to allow the tool to select an
appropriate value.

•

Card—Select the Card. Allowed values are Auto, 10GE-XP, 10GE-EXP, GE-XP, and GE-EXP. Auto
allows the tool to select an appropriate card type based on other constraints.

The Src area contains Working and Protected subareas.
Working sub-area
•

Port CIR—Select the CIR, with 1 being the highest and 0.1 being the lowest.

•

Port Rate-Reach—Select the desired PPM for this port, or set it to Auto to allow the tool to select
an appropriate value.

•

Port Num—Select the port number. Allowed values are Auto, 1, and 2. Auto allows the tool to select
an appropriate port number based on other constraints.

Protected sub-area
These fields are enabled only if client protection is enabled in the Client Protection field.
•

Port CIR—Select the CIR, with 1 being the highest and 0.1 being the lowest.

•

Port Rate-Reach—Select the desired PPM for this port, or set it to Auto to allow the tool to select
an appropriate value.
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•

Port Num—Select the port number. Allowed values are Auto, 1, and 2. Auto allows the tool to select
an appropriate port number based on other constraints.

Dest Area
•

Site—Select the destination site. Allowed values include the list of sites added in the WDM traffic
channel.

•

SFP lambda—Select the desired SFP/XFP for this port or set it to Auto to allow the tool to select an
appropriate value.

•

Card—Select the card. Allowed values are Auto, 10GE-XP, 10GE-EXP, GE-XP, and GE-EXP. Auto
allows the tool to select an appropriate card type based on other constraints.

The Dest area contains Working and Protected subareas.
Working sub-area
•

Port CIR—Select the CIR, with 1 being the highest and 0.1 being the lowest.

•

Port Rate-Reach—Select the desired PPM for this port, or set it to Auto to allow the tool to select
an appropriate value.

•

Port Num—Select the port number. Allowed values are Auto, and 1 to 20. Auto allows the tool to
select an appropriate port number based on other constraints.

Protected sub-area
These fields are enabled only if the client protection is enabled in the Client Protection field.
•

Port CIR—Select the CIR, with 1 being the max and 0.1 being the lowest.

•

Port Rate-Reach—Select the desired PPM for this port, or set it to Auto to allow the tool to select
an appropriate value.

•

Port Num—Select the port number. Allowed values Auto, 1, to 20. Auto allows the tool to select an
appropriate port number based on other constraints.

Step 11

Click OK.

Step 12

If you want to clone this demand, click the Clone button in the left corner of the screen. A new demand,
which is a copy of this demand, is created and appears in the Project Explorer pane.

Step 13

Click the Check tab in the left corner of the window to generate a report showing the circuit path in the
WDM traffic channel and to check any over-allocation of bandwidth (Figure 2-21). The Report tab
shows, in a row, each of the sites on the subnet, and each span in between.

Cisco Transport Planner DWDM Operations Guide, Release 9.1

2-34

78-19089-01

Chapter 2

Creating and Analyzing Networks
Creating a Demand

Figure 2-21

Step 14

Step 15

Circuit Path View in a Ethernet Aggregated Demand

The Traffic tab displays the following details about the circuit:
•

AL—Displays the alarm (if any) for the circuit.

•

Label—Displays the name of the circuit.

•

F—If checked, it is a forecast circuit. If unchecked, it is a present circuit.

•

Src Site—Displays the source site.

•

Dst Site—Displays the destination site.

•

Rate—Displays the circuit rate/bandwidth.

•

Client Prot—Displays the client protection scheme.

•

Trunk Prot—Displays the trunk protection scheme.

•

Message—Displays a message related to the circuit.

The Traffic Result tab displays the following:
•

Label—Displays the name of the circuit.

•

F—If checked, it is a forecast circuit. If unchecked, it is a present circuit.

•

Src Site—Displays the source site.

•

Dst Site—Displays the destination site.

•

Trunk Protection—Displays the trunk protection scheme.

•

Path Forcing—Displays the output Node interface. If no client or trunk protection is used, displays
NA.

•

Client Protection—Displays the client protection scheme.

•

Circuit Rate—Displays the circuit rate/bandwidth.
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•

Src Wrk Port Num—Displays the source working port number.

•

Src Prt Port Num—Displays the source protect port number.

•

Dst Wrk Port Num—Displays the destination working port number.

•

Dst Prt Port Num—Displays the destination protect port number.

•

Src Wrk Port CIR—Displays the source working port CIR. The highest is 1 and 0 the lowest.

•

Src Prt Port CIR—Displays the source protect port CIR. The highest is 1 and 0 the lowest.

•

Dst Wrk Port CIR—Displays the destination working port CIR. The highest is 1 and 0 the lowest.

•

Dst Prt Port CIR—Displays the destination protect port CIR. The highest is 1 and 0 the lowest.

•

Src Wrk Port Rate-Reach—Displays the PPM for the source working port. For example, Rack
1.Shelf 1. Slot 5.

•

Src Prt Port Rate-Reach—Displays the PPM for the source protect port. For example, Rack 1.Shelf
1. Slot 4.

•

Dst Wrk Port Rate-Reach—Displays the PPM for the destination working port.

•

Dst Prt Port Rate-Reach—Displays the PPM for the destination protect port.

•

Src Card—Displays the source card.

•

Dst Card—Displays the destination card.

•

Working Src Card Rack-Shelf-Slot—Displays the the rack, shelf, and slot position of the working
source card.

•

Working Dst Card Rack-Shelf-Slot—Displays the the rack, shelf, and slot position of the working
destination card.

•

Protecting Src Card Rack-Shelf-Slot—Displays the the rack, shelf, and slot position of the protect
source card.

•

Protecting Dst Card Rack-Shelf-Slot—Displays the the rack, shelf, and slot position of the protect
source card.

•

Alarm—Displays the alarm status.

Step 16

To add a regeneration site, click the Regeneration... icon in the toolbar of the DWDM channel tab. The
Regeneration Editor appears. The regeneration site can be created only at the trail level. For more
information, see the “2.7.7 Creating a Regeneration Site” section on page 2-43.

Step 17

Click Close. To edit circuits, see the “4.9 Editing an Ethernet Aggregated Demand” section on
page 4-32.

2.7.6 Creating TDM Aggregated Demands
A TDM aggregated demand is a collection of low-rate SONET and Gigabit Ethernet services that is
aggregated on a single 10-G WDM trunk. The TDM aggregated demand is a specific service demand that
is carried only by the ADM-10G card.
The TDM Aggr Creation wizard allows you to:
•

Create one WDM transport channel at a time over a predefined traffic subnet

•

Specify the wavelength to be used for the channel, and define a list of locations with add/drop STS
circuit capability.
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•

Create a set of STS circuits on this WDM transport channel to pass traffic.

•

The check functionality generates a report showing, for each section of the subnet, where the WDM
transport channel is over allocated and then perform, when required, the corrective action.

The total amount of bandwidth used by all the defined circuits in each section of the WDM transport
channel cannot exceed the maximum channel capacity of STS-192c. Sections exceeding the maximum
capacity are colored red in the report. Demands that fail the check are flagged as invalid demands and
the Analyzer stops.
The clone functionality allows you to create an empty copy of the current WDM transport channel, with
the same add/drop sites and WDM channel configuration parameters. You can then start filling this
channel with the desired circuits.
Use the following procedure to create TDM aggregated demands:
Step 1

In the NtView name tab, click the Create new TDM Aggregated demand icon in the toolbar. For more
information about CTP icons, see Appendix A, “GUI Information and Shortcuts.”
The TDMAggr wizard appears (Figure 2-22).
Figure 2-22

TDM Aggr Creation Wizard

Step 2

Select the desired traffic subnet from the Traffic Subnet drop-down list. You can create a new traffic
subnet if desired using (see 2.6 Creating Traffic Subnet, page 2-19).

Step 3

Click Next.

Step 4

In the General Parameters pane, complete the following tasks:
•

Label—Type the name of the demand. The default value is TDMAggr1.

•

Present/Forecast—Check this box if this demand will be needed in the future; uncheck this box if
this demand is needed now. This parameter drives the list of pluggable port modules to be equipped
on the card and will affect BoM reports.
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Step 5

Click Next.

Step 6

In Sites selection pane, complete the following tasks:

Step 7

•

In the Protection Sites area, press Ctrl and click the sites that you want to add to the TDM
aggregated demand. A TDM aggregated demand requires at least two sites. Click the right arrow
button. To remove a site added to the list, click the site and click the left arrow button.

•

In the Optical Bypass area, press Ctrl and click the sites that you want to add to TDM aggregated
demand. Click the right arrow button. To remove a site added to the list, click the site and click the
left arrow button. If the Present/Forecast check box is checked, you cannot select Optical Bypass
sites. A channel in optical bypass is dropped on one side of the node and added on the other side of
the same node to allow the future use of that node as an add/drop location.

In the Node Configuration selection pane, complete the following tasks:
•

DWDM Trunk—Select the DWDM trunk type to specify the kind of WDM trunk interface for the
card in each allowed add/drop site. Allowed values are:
– Auto
– w/EFEC
– w/FEC
– w/o FEC

•

Wavelength—Allows you to force the current WDM transport channel wavelength. Allowed values
are:
– Auto—Allows CTP to assign a wavelength to the channel with the lowest possible cost, given the

other set of constraints.
– C band-32 ch.odd
– L band- 32 ch.odd
– C band- 40 ch
– C band- 64 ch
– C band- 72 ch
– C band- 80 ch
Step 8

Click Finish. The name Demand window appears (Figure 2-23).
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Figure 2-23

Step 9

TDMAggr Demand Window

To add a circuit, click the Create a new circuit icon. The New Request window appears (Figure 2-24).
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Figure 2-24

Step 10

New Request Window

The New Request window contains four areas of information: Quantity, General, Src, and Dest.
Quantity Area

Quantity—Enter the number of circuits to be created.
General Area
•

Label—Enter the label for the circuit. By default, VLAN_Circuit_x is used.

•

Trunk Protection—Enter the trunk protection type. Allowed values are:
– Unprotected
– UPSR

•

P/F—Select Forecast if this demand will be needed in the future. Select Present if this demand is
needed now. This parameter drives the list of pluggable port modules to be equipped on the card and
affects BoM reports.

•

Path Forcing—This option allows you to force the circuit routing on the traffic subnet associated
with this demand. Allowed values are:
– Auto—(Default) Causes the tool to automatically define the trunk path.
– Side x—Represents the label of the side on the Src site where the circuit is routed.

•

Client Protection—Allowed values are:
– Unprotected
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– 1+1 APS
•

Circuit rate—Displays the allowed circuit rates.

Src Area
•

Site—Select the source site. Allowed values include the list of sites added in the WDM traffic
channel.

•

SFP lambda—Select the desired SFP/XFP for this port or set it to Auto to allow the tool to select an
appropriate value.

•

Card—Select the Card. Allowed values are Auto and ADM-x. Auto allows the tool to select an
appropriate card type based on other constraints.

The Src area contains Working and Protected sub-areas.
Working sub area
•

Port Num—Select the port number. The allowed values are Auto, and from 1 to 17. Selecting Auto
allows the tool to select an appropriate port number based on other constraints.
In addition to ports 1 to 16, port 17 also acts like a client port in TDM aggregated demands.
Following are the guidelines to use port 17:
– Port 17 must be selected only when the ADM-10G card is used in a single-card configuration.
– Port 17 supports the circuit rates VC4-64C/STS-192C. It also supports the circuit rates from

STS1/VC4 to STS-48c/VC4-16c or a combination of them.
– For circuit rates VC4-64C/STS-192C with the port number as Auto, port 17 automatically

becomes the source and the destination port. Port 17 will not be selected for any other circuit
rate unless the user specifically forces the port.
– Port 17 supports UPSR Client Protection on ANSI platform and SNCP client protection on ETSI

platform, except for the circuit rates VC4-64C/STS-192C.
•

Port Rate-Reach—Select the desired PPM for this port or set it to Auto to allow the tool to select an
appropriate value.

Protected sub area
The following fields are available only if client protection is enabled:
•

Port Num—Select the port number. The allowed values are Auto, and from 1 to 17. Selecting Auto
allows the tool to select an appropriate port number based on other constraints.
You can force port 17 as protected source or destination port for Client UPSR/SNCP protection with
circuit rates less than VC4-64/STS-192c.

•

Port Rate-Reach—Select the desired PPM for this port or set it to Auto to allow the tool to select an
appropriate value.

Dest Area
•

Site—Select the destination site. Allowed values include the list of sites added in the WDM traffic
channel.

•

SFP lambda—Select the desired SFP/XFP for this port or set it to Auto to allow the tool to select an
appropriate value.

•

Card—Select the card. Allowed values are Auto and ADM-x. Auto allows the tool to select an
appropriate card type based on other constraints.
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The Dest area contains Working and Protected sub areas.
Working sub area
•

Port Num—Select the port number. The allowed values are Auto, and from 1 to 17. Selecting Auto
allows the tool to select an appropriate port number based on other constraints.
In addition to ports 1 to 16, port 17 also acts like a client port in TDM aggregated demands. The
guidelines to use the port are the same as given in the Working sub area for source ports.

•

Port Rate-Reach—Select the desired PPM for this port, or set it to Auto to allow the tool to select
an appropriate value.

Protected sub-area
•

Port Num—Select the port number. Allowed values are Auto and 1 to 16. Auto allows the tool to
select an appropriate port number based on other constraints.

•

Port Rate-Reach—Select the desired PPM for this port, or set it to Auto to allow the tool to select
an appropriate value.

Step 11

Click OK.

Step 12

If you want to clone this demand, click the Clone button in the left corner of the screen. A new demand,
which is a copy of this demand, is created and appears in the Project Explorer pane.

Step 13

Click the Check tab on the left corner of the window to generate a report showing the circuit path in the
WDM traffic channel and to check any over-allocation of bandwidth (Figure 2-25). The report shows, in
a row, each of the sites on the subnet, and each span in between.
Figure 2-25

Circuit Path View in a TDM Aggregated Demand
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Step 14

To add a regeneration site, click the Regeneration... icon in the toolbar of the DWDM channel tab. The
Regeneration Editor appears. The regeneration site can be created only at the trail level. For more
information, see the “2.7.7 Creating a Regeneration Site” section on page 2-43.

Step 15

Click Close. To edit circuits, see the “4.10 Editing a TDM Aggregated Demand” section on page 4-37.

2.7.7 Creating a Regeneration Site
Use the following procedure to create a regeneration site in the network.

Note

A regeneration site cannot be a site with the functionality as OLA, OSC, pass-through, or hub.

Note

The Regeneration... icon is active only when you select a trail in the Demand Editor.

Step 1

In the Demand Editor, click the Regeneration... icon in the toolbar. The Regeneration Editor appears,
Figure 2-26. For more information about Cisco Transport Planner icons, see Appendix A, “GUI
Information and Shortcuts”.
Figure 2-26

Regeneration Editor
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Step 2

In the Available Sites area, choose the site and click the down arrow icon. To remove a site added to the
Regeneration Sites list, choose the site and click the up arrow icon.

Note

When adding more than one regeneration site to the path, ensure the regeneration sites are added in the
correct sequence to avoid unfeasible routing. For example, if you create a point-to-point demand from
site1 (source) to site 3 (destination), the sites available in the path are site 4 and site 5. Site 5 must be
selected first, followed by site 4, because site 5 is closer to site 1.

Step 3

To sort the regeneration sites in the list, use the up and down arrow icons located on the left.

Step 4

If you chose a source or destination card for a regeneration site, choose the card type for the site from
the drop-down list. The regeneration cards that are compatible with the source and destination cards are
displayed in the interface.

Note

Step 5

Note

The OTU2_XP card has four modes. For more information on these modes, refer to the
“2.7.7.1 Configurations for OTU2_XP” section on page 2-44.
Click OK.

To allow different wavelengths to be used for regeneration, choose the Allow different wavelengths
option in the Properties pane in Net > Options > Traffic Mapping > System Release 9.1.

2.7.7.1 Configurations for OTU2_XP
The OTU2_XP card operates in six different configurations as shown in the following table:

Configuration

Card listed as

Dual Transponder

OTU2-XP-Txp Client port
mode
1

(2 x 10G
transponder)
Dual Regenerator
(2 x 10G standard
regenerator with
enhanced FEC
[E-FEC] only on
one port)

OTU2-XPRegen mode

Single Regenerator OTU2-XPSingle Regen
(1 x 10G E-FEC
mode
regenerator with
E-FEC on two
ports))

Port 1

Port 2

Port 3

Port 4

Client port 2 Trunk port 1

Trunk port 2

Trunk port 1 Trunk port 2 Trunk port 1

Trunk port 2

Not used

Trunk port

Not used

Trunk port
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Configuration

Card listed as

Port 1

Port 2

10 GE LAN Phy to OTU2-XPWAN Phy
Txp mode
Mixed mode
Splitter mode

Client port

Client port Trunk port
in
Note
In a Multi
transponder
trunk card,
or trunk port
the LAN
in
port is
regenerator
always on
configuratio
Port1, and
n
not on port
2.

Trunk port in
transponder or
regenerator
configuration.

OTU2-XPSplitter mode

Client port

Not used

Trunk port
(working)

Trunk port
(protect)

OTU2-XPMixed mode

Client port

Trunk port 4
without
FEC or with
FEC

Trunk port 1
without FEC or
with FEC or
E-FEC

Trunk port 2
without FEC
or with FEC
or E-FEC

Protected
Transponder

Port 3

Port 4

(1 x 10G splitter
protected
transponder)
Mixed Mode
(1 x 10G
transponder and 1 x
10G standard
regenerator)

2.7.7.1.1 Dual Transponder (OTU2-XP-Txp)
You can configure the OTU2_XP card as a dual transponder (Figure 2-27). When configured as a dual
transponder (OTU2-XP-Txp), the card supports two completely independent bidirectional 10-Gbps
services. Port 1 and Port 2 support traffic from or to port 3 and port 4, respectively. Both paths are
completely independent and can support different services. G.709 wrapping or unwrapping and FEC
correction capability can be independently activated on each path.

Client 1

Dual Transponder Configuration

1

3
Trunk 1
NOFEC
FEC
EFEC

OTU2_XP

Client 2

Trunk 2
2

4

273488

Figure 2-27

You can assign one the following service types as the client:
•

OC-192/STM64

•

10GE WAN-PHY

•

10GE LAN-PHY

•

10G-FC
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•

LAN-WAN Conversion

You can set one of the following trunk modes on both trunks for any of the service types:
•

No FEC

•

FEC

•

E-FEC

2.7.7.1.2 Dual Regenerator (OTU2-XP-Regen)
You can configure the OTU2_XP card as a dual regenerator (Figure 2-28). When configured as a dual
regenerator (OTU2-XP-Regen), the unit regenerates two completely independent bidirectional 10-Gbps
signal paths (similar to the OTU2-XP-Txp configuration). In this configuration, all four ports support
DWDM XFPs. You can also independently set G.709 framing and FEC capability for all four ports. You
can enable E-FEC encoding only on ports 3 and 4.
Figure 2-28

Dual Regenerator Configuration

1

Trunk 1

3
Trunk 3
NOFEC
FEC
EFEC

OTU2_XP

Trunk 4
2

4

273489

Trunk 2

You can use the following combinations of trunk modes according to the framing of the service to be
regenerated:
•

OC-192/STM-64 service type:
– Trunk ports 1 and 2: No FEC
– Trunk ports 3 and 4: No FEC

•

OTU-2 service type:
– Trunk ports 1 and 2: FEC
– Trunk ports 3 and 4: FEC

or
– Trunk ports 1 and 2: E-FEC
– Trunk ports 3 and 4: FEC

2.7.7.1.3 Single Regenerator (OTU2-XP- Single Regen)
You can configure the OTU2_XP card as a single regenerator (Figure 2-29). When configured as a single
regenerator (OTU2-XP- Single Regen), the card regenerates only one bidirectional 10-Gbps signal path.
The ports 3 and 4 support DWDM XFPs and G.709 framing as well as E-FEC.
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Figure 2-29

Single-Regenerator Configuration

1

3
Trunk 1
OTU2_XP

EFEC
Trunk 2
4

273490

2

2.7.7.1.4 Protected Transponder (OTU2-XP- Splitter)
You can configure the OTU2_XP card as a protected transponder (Figure 2-30). When configured as a
protected transponder (OTU2-XP- Splitter), the card implements the fiber-switched protection. In this
configuration, the client service on port 1 is transmitted to ports 3 and 4 and then on to both trunks. Only
one signal received from the two trunks on ports 3 and 4 is transmitted to port 1 (the signal from the other
port is only monitored). After detecting a failure on one trunk, the unit automatically switches on the
other port, which restores the signal on port 1. In protected-transponder configurations, port 2 is always
disabled.
Figure 2-30

Client

Protected-Transponder Configuration

1

3
Trunk W
NOFEC
FEC
EFEC

OTU2_XP

Trunk P
4
273491

2

You can set one of the following service type for the client port:
•

OC-192/STM64

•

10GE WAN-PHY

•

10GE LAN-PHY

•

10G-FC

•

LAN-WAN Conversion

You can set one of the following trunk modes on both trunks for any of the service types:
•

No FEC

•

FEC

•

E-FEC
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2.7.7.1.5 Mixed Mode (OTU2-XP- Mixed)
You can configure the OTU2_XP card in mixed mode (Figure 2-31). When configured in mixed mode
(OTU2-XP- Mixed), the card is a regenerator on one set of the ports and a transponder on the other set.
The two sets are completely independent and can be configured to transmit or regenerate different
services. You can independently set G.709 framing and FEC capability on each trunk port, but ports 1
and 2 cannot have E-FEC encoding.
Mixed-Mode Configuration

Client 1

1

3
Trunk 1
NOFEC
FEC
EFEC

OTU2_XP
NOFEC
FEC

Trunk 4

Trunk 2
2

4

273492

Figure 2-31

You can swap the configuration of the two sets, that is, ports 1 to 3 set as the regenerator and ports 2 and
4 as the transponder.
You can set one of the following service types for the client port:
•

OC-192/STM64

•

10GE WAN-PHY

•

10GE LAN-PHY

•

10G-FC

•

OTU2

•

LAN-WAN Conversion

You can set one of the following trunk modes on all the trunks for all service types:
•

No FEC (all)

•

FEC (all)

•

E-FEC (only to ports 3 and 4)

CTP does not automatically select mixed mode for OTU2_XP cards. You need to select mixed mode for
an OTU2_XP card to force it.

Note

The FI and FC demands are not supported on port 2 as a source when the LAN-WAN traffic is fed as a
source on port 1.
For further information on the OTU2_XP card, refer to the Cisco ONS 15454 DWDM Reference Guide,
Release 9.1

2.8 Viewing Circuits in a Network
You can view all the circuits that have been created in any of the Service Demands folders in the Traffic
tab of the Net1 tab.

Cisco Transport Planner DWDM Operations Guide, Release 9.1

2-48

78-19089-01

Chapter 2

Creating and Analyzing Networks
Analyzing the Network

The following columns are displayed:
•

SA—Indicates the system alarms that affect the circuit. This indication is available only after the
network is analysed.

•

AL— Indicates the optical alarms that affect the circuit.This indication is available only after the
network is analysed.

•

F—Indicates if the demand will be needed in the future.

•

Demand —Displays the name of the demand.

•

Group—Displays the demand group to which the circuit belongs.

•

Label —Displays the label of the circuit.

•

TMSubnet—Displays the name of the traffic subnet in which the circuit is defined.

•

SrvType— Displays the service type value.

•

Sites—Lists the add/drop site.

•

Card/TrunkType—Displays the card type and trunk type.

•

Protection type— Displays the protection type of the demand.

•

Wavelength —Displays the assigned wavelength.

You can edit the circuits for any demand by double-clicking the circuit or by choosing the circuit and
clicking the Edit button in the toolbar.
Use any one of the following options to group and order the circuits:

Note

•

Type\Demand\Group— The circuits are first grouped and ordered by demand name. Each set of
circuits with the same demand name is then ordered by the group name.

•

SrvType\Type\group—The circuits are first grouped and ordered by service type. Each set of circuits
with the same service type is then ordered by the group name.

You can also select a set of fields in a particular order in the Group by dialog box to build a grouping
rule to be applied to the table.

2.9 Analyzing the Network
After you have created the desired sites, fiber spans, and service demands, you must analyze the network
to determine network performance. The network must be in the Design, Install, or Upgrade state before
you can analyze it. Cisco Transport Planner automatically optimizes the design and summarizes the
optical transmission performance. If there are problems with the design, Cisco Transport Planner lists
the problems and descriptions in the Analyzer Messages pane.
Use the following procedure to analyze the network:
Step 1

Click the Mgmt Tree tab, and click the network that you want to analyze.

Step 2

Click the Analyze Network icon in the toolbar. For more information about the Cisco Transport Planner
icons, see Appendix A, “GUI Information and Shortcuts.” As an alternative, click Analyze in the Tasks
Pane.
The Cisco Transport Planner analysis status bar indicates when the network analysis is complete.
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Step 3

If any problems occur during the analysis, click the Analyzer tab to view the results on the Analyzer
Messages pane. The Summary report appears. See the “3.2.1 Viewing the Summary Report” section on
page 3-2 for more information. Warning and error messages help you identify problems with your
current design. For a list of all system messages, see Appendix C, “System Messages.”

Step 4

If necessary, resolve the problems listed in the Summary report. After you resolve the problems in the
network, you can analyze the network again.

Note

You can return a Design-Analyzed network to the design state to make further changes by clicking the
network icon in the Mgmt Tree and clicking Design in the Tasks Pane.

2.9.1 Viewing the Site Functional View
The Site Functional View displays a graphical view of the circuit connections, optical power, alarms, and
signal loss of a selected site. After you have created the desired sites, fiber spans, and service demands,
and analyzed the network, you can now view the Site Functional View. All the cards in each side are
grouped together.
You can view the site functional view in either of the following ways:
•

Right-click on the Site in the Project Explorer and select Open Site Functional View.

•

In the Network view, right-click on the Site and select Open Site Functional View.

•

Select the Site in the Network view and click Open Site Functional View in the Tasks Pane.

The Site Functional View of a selected site is displayed in a new tab. Double-click a side to see the details
of that side. To return to the normal view, right-click on the side and click Close Node.

2.9.1.1 Changing the View
You can change the view of the the graphical display to view the layout information in detail. Right-click
on the sides of the image (grey area outside the image) to change the view.
You can select the following:
•

Fit to View—Fits the side view into the available display space.

•

Zoom In—Magnifies the view of the graphical display.

•

Zoom Out—Shrinks the view of the graphical display

2.9.1.2 Alarm Information
Within the side display, an alarm box is shown that gives the alarm count for the Critical (CR), Major
(MJ), and Minor (MN) alarms that affect that side. The alarm associated with the card is indicated to
reflect the severity of the alarm (red, orange, and yellow).

2.9.1.3 Transponder and Muxponder Connections
All the transponder and muxponder cards with the patchcords are grouped together. To open and view
the transponder and muxponder connections, right-click the patch panel and select Open Patch Panel.

Cisco Transport Planner DWDM Operations Guide, Release 9.1

2-50

78-19089-01

Chapter 2

Creating and Analyzing Networks
Managing the Network Design

2.10 Managing the Network Design
After creating and analyzing a network design, you must prepare the design for installation at a customer
site. After a network has been installed, you can reanalyze to correct any problems.
Network designs have several possible states:
•

Design—The initial state for any new network design. You can add, delete, or change any aspect of
the network design. In the Design state, no locks exist. After analyzing a design, you can put it back
into the Design state to modify it by choosing Design in the Tasks Pane.

•

Design-Analyzed—The state of the network design after you run the network analyzer. All reports
are available and updated. You cannot change any aspect of the network design. You can modify the
BoM, such as changing global discounts and spare parts. You can return to the Design state after
analyzing the network by choosing Design in the Tasks Pane.

•

Copy—A copy of a network. You can create a copy of a network in any state. A copy is useful for
testing different design options. You can copy a network before or after analyzing it. A copied
network inherits the set of project options defined in the original network. For more information,
see the “2.10.1 Creating a Copy of the Network” section on page 2-52.

•

Install—A network is initially designed with theoretical fiber values (such as loss, length, etc.).
When a network is installed in the field, you can move the network into the Install state so that you
can enter and check the real fiber parameter values. You can create an Install network from a network
in the Design-Analyzed or Upgrade-Analyzed state. A network in the Install state inherits the set of
project options defined in the analyzed network. All sites in an Install network are locked. You
cannot modify any aspect of the network design except the span parameters and (on unlocked sites)
amplifiers. You can, however, modify the BoM. All routed circuits are fixed, and cannot be changed
while in this state. For more information, see the “2.10.2 Creating a Network in the Install State”
section on page 2-52.

•

Install-Analyzed—The state of the Install network design after you run the network analyzer. All
reports are available and updated. Cisco Transport Planner locks all sites, spans, demands, and
equipment when a network is in the Install-Analyzed state.

•

Upgrade—During network design, you define a number of the channels to be implemented at the
present time and a number of channels to be implemented in the future (forecast). After installing
the network, you might decide to implement the forecast circuits. To do this, you create an Upgrade
network and then select the forecast or traffic demand services that you want to implement. You can
create an Upgrade network from a network in the Design-Analyzed or Install-Analyzed state. You
can unlock specified parameters to alter the design to include forecasted channels and traffic
demands. A network in the Upgrade state inherits the set of project options defined in the analyzed
network. For more information, see the “2.10.3 Creating an Upgrade Network” section on
page 2-52.

•

Upgrade-Analyzed—The state of the Upgrade network design after you run the network analyzer.
All reports are available and updated. Cisco Transport Planner locks all sites, spans, demands, and
equipment when a network is in the Upgrade state.

To complete the procedures in this section, you must have a project open and the network(s) loaded. See
the “1.4.1 Opening a Project” section on page 1-17 and the “1.4.2 Loading and Unloading Networks”
section on page 1-18.
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2.10.1 Creating a Copy of the Network
To create a copy of a network in any state, right-click the network and choose Copy from the shortcut
menu. A new copy appears in the Network Mgmt Tree tab.

2.10.2 Creating a Network in the Install State
Use the following procedure to create a network in the Install state:
Step 1

If the network is not analyzed, complete the “2.9 Analyzing the Network” section on page 2-49.

Step 2

Click the Mgmt Tree tab.

Step 3

Right-click the network and choose Install from the shortcut menu. A new network appears in the Mgmt
Tree in the Install state. All results from the analyzed network are imported into the Install network and
are placed in the Locked mode.

Step 4

Make the necessary changes to the Install network. You can edit the following fiber parameters: fiber
loss value, fiber CD, fiber PMD, and fiber length. See the “4.11 Editing Fiber Span, Pair, and Fiber
Parameters” section on page 4-42. Cisco Transport Planner also allows you to unlock site parameters for
modification. To change site parameters, see the “4.3 Editing Site Parameters” section on page 4-2.

Step 5

In the Mgmt Tree view, click the Analyze Network icon in the toolbar. For more information about the
Cisco Transport Planner icons, see Appendix A, “GUI Information and Shortcuts.” The Transport
Planner Analyzer status window appears to indicate the progress. As an alternative, click Analyze in the
Tasks Pane. The Cisco Transport Planner analysis status bar indicates when the network analysis is
complete. The network now appears in the Install-Analyzed state.

Note

Step 6

If you have changed parameters that are inconsistent with the present network layout (for
example, if you set an output tilt value that the amplifier cannot reach), during network analysis
an error message on the Analyzer Messages pane identifies which parameter is causing the
problem. Warning and error messages help you identify problems with your current design. For
a list of all system messages, see Appendix C, “System Messages.”

When you have analyzed the network and are satisfied with the results, import the new generated
installation parameters to each site of the network. For more information, see the “3.2.2 Saving the NE
Update File” section on page 3-3.

2.10.3 Creating an Upgrade Network
Use the following procedure to put a network in the Upgrade state:
Step 1

If the network is not analyzed, complete Analyzing the Network, page 49.

Step 2

Click the Mgmt Tree tab.
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Step 3

Right-click the analyzed network and choose Upgrade from the shortcut menu. A new Upgrade network
appears in the Mgmt Tree tab. All results from the analyzed network are imported into the Upgrade
network.

Step 4

Make the necessary changes to the Upgrade network. For more information, see the Editing Fiber Span,
Pair, and Fiber Parameters, page 42 and the Editing Site Parameters, page 2.

Step 5

In the Mgmt Tree view, click the Analyze Network icon in the toolbar. For more information about
Cisco Transport Planner icons, see Appendix A, “GUI Information and Shortcuts.” The Transport
Planner Analyzer status window appears to indicate the progress. As an alternative, click Analyze in the
Tasks pane in any view. The Cisco Transport Planner analysis status bar indicates when the network
analysis is complete. The network now appears in the Upgrade-Analyzed state.

Note

If you have changed parameters that are inconsistent with the present network layout (for
example, if you set an output tilt value that the amplifier cannot reach), during network analysis
an error message on the Analyzer Messages pane identifies which parameter is causing the
problem. Warning and error messages can help you identify problems with your current design.
For a list of all system messages, see Appendix C, “System Messages.”

In an Upgrade network, you can perform the following tasks:
•

Modify the fiber span properties (such as length, dispersion, PMD coefficient, excess losses, and
aging).

•

Add or delete traffic

•

Convert forecasted traffic to present traffic

•

Finalize ROADM traffic to present traffic

•

Modify the type of a node

•

Force the presence or the absence of a card or a module (this includes amplifiers, OSC modules,
OADM cards, and DCU modules)

In an Upgrade network, you can force certain installation parameters:
•

Amplifier per-channel output power setpoint

•

Amplifier output tilt setpoint

•

OADM card aggregate output power setpoint

•

Full multiplexer/demultiplexer or ROADM output power setpoint

You cannot change the following parameters when in Upgrade state:
•

Node input channel fail threshold

•

Node OSC channel fail threshold

•

Preamplifier input power threshold

•

OADM card aggregate input power setpoint

•

Full muxponder/demuxponder or ROADM input power setpoint

•

Channel drop power

When upgrading a network that has a point-to-point demand, you can:
•

Move Future circuits to become Present. This move can be done without unlocking the circuit.

Cisco Transport Planner DWDM Operations Guide, Release 9.1
78-19089-01

2-53

Chapter 2

Creating and Analyzing Networks

Managing the Network Design

•

Add new, present, or future point-to-point services to the existing demand.

•

Delete any present or future channel originally defined in the baseline network.

•

Change any unlocked point-to-point circuit or unlocked point-to-point service demand parameter.

When upgrading a network that has an any-to-any demand, you can:

Note

•

Move any of the Any-to-Any (future) services to become Present. This move can be done without
unlocking the circuit.

•

Create a new Any-to-Any demand on an already existing Any-to-Any group.

•

Create a new Any-to-Any group.

•

Delete an existing Any-to-Any demand from an Any-to-Any group.

•

Delete an Any-to-Any group with all of its Any-to-Any demands.

Any-to-Any services that have been moved to Present will be represented as Point-to-Point services.

2.10.4 Unlocking Parameters in the Network Design
The Locked state occurs when no value is set for a parameter and Auto option is selected. During
network analysis, Cisco Transport Planner assigns a value for each parameter set with Auto and puts
them in the Locked state. The Locked state indicates that the next time the network is analyzed, the
analyzer cannot change the value. Locking a site forces the presence or absence of all preamplifiers,
boosters, add/drop filters, TDCU, and DCU units that the site/network requires as a result of running the
analyzer previously.
Locked elements are indicated by a closed padlock icon in the Project Explorer. For more information
on the Auto, forced, and locked states, see the “1.1.6 Auto, Forced, and Locked Parameters” section on
page 1-14.
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Figure 2-32

Unlocking Network in the Project Explorer View

To unlock network components, right-click the desired element in Upgrade or Install mode in the Project
Explorer area and choose Unlock from the shortcut menu (Figure 2-32). You can unlock at the network
level or the site level or the element level. Unlocking items at higher level unlocks all elements under
that level.

2.10.4.1 Forcing Manager
Forcing Manager enables you to unlock multiple interfaces connected to various ducts and sites. This
helps you unlock a group of sites and ducts based on individual units such as amplifiers, DCUs, add/drop
units, band parameters, and node layout.
For example, you can unlock all the amplifiers, TDCUs, and DCUs of all the sites in the network in one
go, with the help of Forcing Manager.
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Use the following procedure to unlock multiple units in different sites/ducts:
Step 1

Right-click the network folder in the Project Explorer and choose Forcing Manager from the shortcut
menu. The Forcing Manager dialog appears.
To create an upgrade network, see 2.10.3 Creating an Upgrade Network.
Forcing Manger can be used in both the design mode and the upgrade mode.

Step 2

Choose any one of the following options from the left pane of the Forcing Manager dialog:
•

Sites—When a site is selected, all the interfaces under that site will be selected.

•

Ducts—When a duct is selected, both the interfaces associated with the duct are selected.

The list of sites and ducts available for selection is displayed in the left pane. If you choose the option
sites, the list of ducts are disabled. When you choose ducts, the list of sites are disabled.
Figure 2-33

Step 3

Forcing Manager Dialog Box

Choose the required sites/ducts that need to be unlocked.
The network layout is displayed in the right pane of the Forcing Manager dialog. The chosen sites/ducts
are highlighted in a different color.

Step 4

Click Select to select the individual units from the site/duct.

Step 5

Click Close to the close the Forcing Manager dialog.

Step 6

Click Help to display the Help content for CTP.

Step 7

Clicking Select to open the Select Units to Force dialog box.
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Figure 2-34

Step 8

Select Units to Force Dialog Box

Select any one of the following options from the Select Units to Force dialog box:
•

Unlock Tree—Unlocks all the units from the selected sites/ducts.

•

Unlock Individual Item—From the chosen sites/ducts, you can unlock one or more of the following
items:
– Amplifier units—Unlocking an amplifier will unlock the DCUs in a particular interface.
– TDCU—Can be unlocked without unlocking amplifiers.
– DCUs—Can be unlocked without unlocking amplifiers.
– Add/Drop units
– WDM-ANS Optical Parameters
– NodeLayout—Unlocking a node unlocks all its children. This option is not available for ducts,

as it is a site parameter.
•

Reset to Auto—Choose one or more of the following items to reset the values:
– Amplifier units
– DCUs
– Add/Drop units

Step 9

Click Apply to apply the changes to the network.

Step 10

Click Cancel to cancel the changes and close the dialog box.

Step 11

Click Help to display the Help content for CTP.
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Figure 2-35

Step 12

Summary Dialog Box

Click OK to close the Forcing Manager Dialog box.

2.10.5 Creating a JPEG of the Network Design
Use the following procedure to create a snapshot of your network design in JPEG format:
Step 1

Click the NtView Name tab.

Step 2

Complete the “4.16 Arranging Sites” section on page 4-76 as necessary so that the sites in the network
appear in the tab in the desired arrangement.

Step 3

Click the Save network view image icon in the toolbar.

Step 4

In the Save network view image dialog box, navigate to the desired directory.

Step 5

Enter the file name in the File Name field and click Save.

2.10.6 Upgrading to CTP Software Release 9.1
Use the following procedures to upgrade a release to CTP Software Release 9.1:

Note

•

CTP Release 9.1 supports upgrading CTP Software Release 7.0 and later.

•

You can upgrade a software release only to its next highest supported release. For example, Release
7.0 can be upgraded to Release 8.0 but not to Release 8.5.

Step 1

From the File menu, click Open to load the saved CTP project (Release 7.0 and later).

Step 2

Right-click on the network loaded in the Project Explorer and choose Release Upgrade.
CTP automatically creates a copy of the initially loaded network and updates the system release to the
next highest release. The newly created copy is moved into the Upgrade administrative state.
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Step 3

Note

Repeat Step 2 until the release is upgraded to Release 9.1.

The tool allows you to manually enter the details of a deployed network even if the Cisco Transport
Planner design file is not available. You can perform a release upgrade only on a network that has been
analyzed.

2.11 Generating a BoM
You can generate a BoM when a network is in the Install or Upgrade state, or after you have successfully
analyzed your network design. The price database selected during project creation is used to generate
the BoM.
To complete the procedures in this section, you must have a project open and the network(s) loaded. See
the “1.4.1 Opening a Project” section on page 1-17 and the “1.4.2 Loading and Unloading Networks”
section on page 1-18.

2.11.1 Viewing BoM Report Totals
Use the following procedure to view the BoM report totals:
Step 1

Click the Mgmt Tree tab and click the network.

Step 2

In the Tasks Pane, click Bill of Material. The Bill of Material tab appears. As an alternative, you can
access this report by choosing Bill of Materials from the Reports folder in the Project Explorer tree.
The upper section of the BoM tab (in the Net view, Site view, and Spare subtabs) displays the following
information:
•

BoM total discounted—Displays the price for the overall network (without spare parts) for each item
in the BoM. If Use global discount is checked, the total includes the discount from the Global
discount percentage field.

•

Spare total discounted—Displays the price for all of the recommended spare parts in all of the
maintenance centers for the overall network. It is the sum of each spare item using the discounted
price. The total appears after you check the Spare Part Report check box.

•

BoM + Spare total discounted—Displays the sum of the BoM total discounted price and spare total
discounted price.

•

Price List—Displays the name of the price list database selected for the project.

•

Price List last update—Displays the date that the selected price list was last updated.

•

Currency—Displays the value of the currency used for each of the price values as specified within
the selected price list database.

Step 3

To use the Multishelf Management Integrated Kit bundle when generating the BoM instead of the single
items, check Use MSM bundle.

Step 4

Check Spare Part Report to include the spare parts in the report totals.
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Note
Step 5

You can only check the Spare Part Report check box if the network is in Design mode.

The Global discount percentage field shows the percentage from the Global Discount Percentage option
in the Default Project Options window. To change the global discount for the entire network, check
Use global discount and enter a new global discount in the form of a percentage in the Global discount
percentage field. The global discount is applied to all components in the BoM and will overwrite any
discount specified in the Global Price List.

2.11.2 Generating a Network BoM
Use the following procedure to generate a BoM for the network:
Step 1

Click the Mgmt Tree tab and click the network.

Step 2

In the Tasks Pane, click Bill of Material. The Bill of Material tab (Figure 2-36) appears. The Net View
subtab is selected by default. Items that are not found appear in yellow in the BOM.
Figure 2-36

Bill of Material Tab, Net View Subtab

Table 2-4 describes the Net view subtab columns. See the “2.11.1 Viewing BoM Report Totals” section
on page 2-59 for a description of the data, check boxes, and fields at the top of the window.
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Table 2-4

Step 3

BoM Net View Columns

Column Label

Description

Product ID

Displays the ordering code used to order the BoM from Cisco.

Description

Displays a description of the product.

Quantity

Displays the number of specific products in the BoM.

Unit price

Displays the price for each unit. If the price does not appear, Invalid will
display. This occurs when the price list reports “NaN” (Not a Number) for the
item because the price list has never been updated. Invalid items appear in the
list in red. Items that have not been updated from CCO appear in yellow.

Unit Discount

Displays the per-unit discount amount that you assigned in the Global Discount
Percentage field. If you leave the field blank, the field displays the default
value from the Price List database.

Total price

Displays the total price of the products before applying the discount.

Discounted Total
Price

Displays the total price of the products after applying the discount.

Site #

Displays the number of products to be assigned to a particular site. The number
of Site columns is the same as the number of sites in the network.

To close the Bill of Material report, click the X in the upper right corner of the Bill of Material tab.

2.11.3 Generating a Site BoM
A site BoM lists all of the hardware and software parts required for the system to work as designed at a
given site. Use the following procedure to generate a BoM for a site:
Step 1

Click the NtView Name tab and click the site.

Step 2

In the Tasks Pane, click Bill of Material. The Site view subtab is selected by default (Figure 2-37). Items
that do not appear in the price list appear in red.
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Figure 2-37

Bill of Material Tab, Site View Subtab

Table 2-5 describes the Site view subtab columns. See the “2.11.1 Viewing BoM Report Totals” section
on page 2-59 for a description of the data, check boxes, and fields at the top of the window.
Table 2-5

BoM Site View Columns

Column Label

Description

Name

Displays the site name. Click the plus (+) sign to expand the site and display
the categories. Click the plus (+) sign to expand each category to view the
items in the BoM.

Product ID

Displays the ordering code used to order the BoM from Cisco.

Quantity

Displays the number of that specific item in the BoM.

Unit price

Displays the price for each unit. If the price does not appear, Invalid will
display. This occurs when the price list reports “NaN” (Not a Number) for the
item because the price list has never been updated. Invalid items appear in the
list in red. Items that have not been updated from CCO appear in yellow.

Unit Discount

Displays the per-unit discount amount that you assigned in the Global Discount
Percentage field. If you leave the field blank, the field displays the default
value from the Price List database.

Total Price

Displays the total price of the products before applying the discount.

Discounted Total
Price

Displays the total price of the products after applying the discount.
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Step 3

To close the Bill of Material report, click the X in the upper-right corner of the Bill of Material tab.

2.11.4 Generating a Spare Parts Report
After you generate the BoM, use the following procedure to determine the spare parts required by the
network. If the network is in the Upgrade state, the report includes the parts required to support the
implemented services and the new additional present services. To generate a spare parts report, you must
associate a site with a maintenance center before network analysis. For more information, see the
“4.3 Editing Site Parameters” section on page 4-2.
Step 1

Click the Mgmt Tree tab and click the network.

Step 2

In the Tasks Pane, click Bill of Material. Click the Spare subtab (Figure 2-38).
Figure 2-38

Bill of Material Tab, Spare Subtab

Table 2-6 describes the Spare subtab columns. See the “2.11.1 Viewing BoM Report Totals” section on
page 2-59 for a description of the data, check boxes, and fields at the top of the window.
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Table 2-6

Step 3

BoM Spare Subtab Columns

Column Label

Description

Name

Displays the name of the item at the site. Right-click the maintenance center
and choose Expand All from the shortcut menu to view all spare parts.

Product ID

Displays the ordering code used to order the BoM from Cisco.

Quantity

Displays the number of specific items in the BoM.

Unit price

Displays the price for each unit. If the price does not appear, Invalid will
display. This occurs when the price list reports “NaN” (Not a Number) for the
item because the price list has never been updated. Invalid items appear in the
list in red. Items that have not been updated from CCO appear in yellow.

Unit Discount

Displays the per-unit discount amount that you assigned in the Global Discount
Percentage field. If you leave the field blank, the field displays the default
value from the Price List database.

Total Price

Displays the total price of the parts before applying the discount.

Discounted Total
Price

Displays the total price of the parts after applying the discount.

To close the Bill of Material report, click the X in the upper right corner of the Bill of Material tab.

2.11.5 Exporting a BoM
Use the following procedure to export the BoM to an external file in XML, Excel spreadsheet, HTML,
or text format:
Step 1

Click the Mgmt Tree tab and click the network.

Step 2

In the Tasks Pane, click Bill of Material. The Bill of Material tab appears.

Step 3

Click Export. The BoM export dialog box appears.

Step 4

In the BoM export dialog box, type the name of the file, choose the file type (.xls and .html) from the
drop-down list, and navigate to the desired folder. Click Save.

2.12 Managing the Price List
A price list is defined for each project and is used to generate a BoM. Cisco Transport Planner can
manage multiple price lists. You can even change a project price list after a project has been established.
The Master Price list is the Global Price List in US dollars. You can download new price lists from Cisco
Connection Online (CCO).
Only the selected price value is saved with a project; the actual price database is not saved with the
project. When opening a saved project (for example, a project received from another designer), the
associated price database might not be available. If this is the case, Cisco Transport Planner notifies you
that the Master Price list will be used.
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To save memory, Cisco Transport Planner automatically loads only the price list selected for the current
project.

2.12.1 Creating a New Price List
Use the following procedure to download a price list from CCO. You can download price lists from CCO
if no projects are currently open.
Step 1

If a project is open, close the project. See the “1.4.4 Closing a Project” section on page 1-19.

Step 2

From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-39).
Figure 2-39

Price Manager Dialog Box

Step 3

In the Price Manager dialog box, right click PriceDBManager and choose New Price DB from the
shortcut menu.

Step 4

In the Create a New Price DB dialog box, enter the price list name.

Step 5

From the drop-down list, choose the desired CCO price list.

Step 6

Click OK.

Step 7

Click OK to update from CCO.

Step 8

In the CCO User Name/Password dialog box, type your user name and password, and click OK.
Cisco Transport Planner downloads the CCO price list.

Step 9

When the update is complete, click OK to close the confirmation dialog box. The new price list appears
in the PriceDBManager tree.
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Step 10

Click Close to close the Price Manager dialog box.

2.12.2 Viewing a Price List
Use the following procedure to view and filter a price list:
Step 1

From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-39 on
page 2-65).
The PriceDB Manager tree lists all of the created price lists. To save memory, Cisco Transport Planner
automatically loads only the price list selected for the current project (unless the user requests
otherwise). An L indicates that the price list is loaded in memory and is available. A U indicates that a
price list is currently not loaded in memory and is not available.

Step 2

To load or unload a price list, right-click a price list and choose Load or Unload from the shortcut menu.

Step 3

Click PriceList under the desired price list identifier in the PriceDBManager tree. The list displays in
the right pane of the Price Manager dialog box. The properties of the price list appear in the bottom left
corner of the Price Manager dialog box:
•

Last update—Indicates the date of the last download from CCO for this price list. If Never appears,
this indicates that the user created a price list without downloading from CCO.

•

Updated by—Identifies the way in which the price list was updated.

The price list displays the following columns:
•

Price List ID—For internal use.

•

Major Parent ID—Lists the platform.

•

Minor Parent ID—Lists the equipment type.

•

Product ID—Identifies the ordering code for the specific unit.

•

Description—Provides detail about the item.

•

Service Category—For future use.

•

List Price—Indicates the price of the item. If NaN (Not a Number) appears in the field, the list has
not been updated.

•

Major ID—For internal use.

•

Minor ID— For internal use.

•

Update Status—Identifies how the last update was made to an item:
– None—Indicates that the price list has never been updated.
– local_file—Indicates that the price list has been updated from a local file.
– cco—Indicates that the price list has been updated from CCO.
– user—Indicates that the price list has been manually updated by the user who directly edited the

price list. The user can modify the Discount field.
•

Discount—If a discount applies, identifies the discount percentage. To modify this field, enter the
new percentage.
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Step 4

To search for a specific item in a price list, type the desired item in the Search field at the top of the list.
As you type, Cisco Transport Planner filters the list items to match your search entry. To choose Search
options, click the Search Tool icon to the left of the Search field and choose one of the following:
•

Column name—Searches only the specified column for the search string. The All option searches
all columns.

•

Case sensitive—Matches the case of the search string.

•

Case insensitive—Disregards the case of the search string.

•

Match from start—Searches only for the search string if it appears at the beginning of column text.

•

Match any where—Searches for the search string if it appears anywhere in the price list.

Step 5

To sort the items in the price list, click on a column to sort by that column.

Step 6

Click Close to close the Price Manager dialog box.

2.12.3 Loading and Unloading Price Lists
To save memory, Cisco Transport Planner automatically loads only the price list selected for the current
project. An “L” by a price list in the Price Manager dialog box indicates that the price list is loaded; a
“U” in the Price Manager dialog box indicates that the price list is not loaded. Use the following
procedure to load or unload price lists in Cisco Transport Planner:
Step 1

From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-39 on
page 2-65).

Step 2

Right-click the price list and choose Load or Unload from the shortcut menu.

2.12.4 Updating a Price List from CCO
Use the following procedure to update a specified price list from CCO or from a local file. You can also
update all price lists, even the lists that are not currently loaded. You can update a price lists from CCO
if no projects are currently open.
Step 1

If a project is open, close the project. See the “1.4.4 Closing a Project” section on page 1-19.

Step 2

From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-39 on
page 2-65).

Step 3

Right-click the desired price list identifier in the PriceDBManager tree and choose Expand from the
shortcut menu.

Step 4

Right-click the desired price list in the expanded tree and choose UpdateFromCCO from the shortcut
menu.

Step 5

In the Update from CCO dialog box, choose Update single price list to download data for the specified
list or Update all price lists to download the latest data for all price lists.

Step 6

In the CCO User Name/Password dialog box, type your user name and password and click OK.
Cisco Transport Planner downloads the price list.
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Step 7

When the update is complete, click OK to close the confirmation dialog box.

Step 8

Click Close to close the Price Manager dialog box.

2.12.5 Copying a Price List
Use the following procedure to create a new price list by copying from an existing one. The new price
list will have all of the attributes and values of the original price list (such as Updated By, Last Update,
unit price, discounts, and so on). You can copy a price list if no projects are currently open.
Step 1

If a project is open, close the project. See the “1.4.4 Closing a Project” section on page 1-19.

Step 2

From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-39 on
page 2-65).

Step 3

Right-click the desired price list in the PriceDBManager tree and choose Copy from the shortcut menu.

Step 4

Type the name for the new price list and click Ok. The new price list appears in the PriceDBManager
tree.

Step 5

Click Close to close the Price Manager dialog box.

2.12.6 Deleting a Price List
Use the following procedure to delete a price list. You cannot delete the Master Price List or a price list
that is in use by a project. You can delete a price list if no projects are currently open.
Step 1

If a project is open, close the project. See the “1.4.4 Closing a Project” section on page 1-19.

Step 2

From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-39 on
page 2-65).

Step 3

Right-click the desired price list in the PriceDBManager tree and choose Delete from the shortcut menu.

Step 4

Click Close to close the Price Manager dialog box.

2.12.7 Viewing Maintenance Contracts
Use the following procedure to view maintenance contracts:
Step 1

From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-39 on
page 2-65).

Step 2

Right-click Maintenance Contracts and choose Expand from the shortcut menu.

Step 3

Click ContractsList. The Contract PID column lists the service contract identifiers for the hardware and
software parts used by Cisco Transport Planner. The Contract Category column describes the service
programs.
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Step 4

Click MapPidsContracts. The PID column lists the product identifiers. The Contracts column lists the
service contract identifier.

Step 5

Click Close to close the Price Manager dialog box.
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